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Introduction
Greg Hamer
greg@halcyonsolutions.net

Web application developer, entrepreneur and 
educator

Flex 2, Flash (since MX), Flash Media Server, Flash Video, 
ColdFusion, Java, SQL (MySQL, Microsoft, Sybase), 
HTML.

Adobe Certified Instructor (all of the above)

Active Developer (all of the above)
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Who This Session is Targeted At
Developers not yet using Cairngorm

Developers who have encountered 
Cairngorm and do not yet fully grasp the 
Cairngorm code authoring model

Managers

Importantly, people who have to 
persuasively state the case in favor of 
adopting Cairngorm, ie "sell" adoption
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Attendee Current Skill Survey
SHOW OF HANDS …

How many currently using Cairngorm?
How many currently very comfortable using?

How many have Cairngorm apps in production?

How many got thrown into Cairngorm? (e.g. 
because you joined a team using Cairngorm)

How many have heard buzz about Cairngorm 
and are here to find out whassup?
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OVERVIEW
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Synopis
Cairngorm is a "microarchitecture"

Cairngorm integrates a number of Design 
Patterns that are well established and well 
documented.

Cairngorm's microarchitecture is documented in 
series of 6  articles by Steven Webster.  

First article here:
http://www.macromedia.com/devnet/flex/articles/cairngorm_pt1.html
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Process – Getting Started w/ Cairngorm
Download Cairngorm Classes/SWC

http://labs.adobe.com/wiki/index.php/Cairngorm

Add the Cairngorm SWC to project library path
Select project in Navigator
From menu:  Project > Properties > Flex Build Path > 
Library Path > Add SWC

Implement directory structure and application 
classes using Cairgorm

Optionally generate class skeletons using code 
generators

Build your view classes
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When To Use and Not To Use
The use of Cairngorm introduces additional 
overhead to the development process.
Due to additional overhead, following project 
types offer limited opportunity for payback 
imposed by the additional overhead:

Small or micro applications, i.e. only one or two views
Short-lived, i.e. prototypes
Solo developers

The more large scale, long-lived and larger the 
development team the more the benefits.
For more, see "Why I think you shouldn’t use 
Cairngorm" by Steven Webster:
http://weblogs.macromedia.com/swebster/archives/2006/08/why_i_think_you.cfm
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What is Up With That Name -> Cairngorm
Started as open source project

Committers were with Iteration::Two
Based in Glascow Scotland

With open source, project founders get to pick 
the name  ;-)

Cairngorm Mountain is in Scotland and is the 
tallest peak in the UK

Who knew there was skiing in the UK?  There is on 
Cairngorm Mountain :-)

For details, see:  http://cairngormmountain.co.uk/
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Not Commercial, Not Open Source
Cairngorm is not a commercial product

Package names originally org.nevis then 
com.iterationtwo

Macromedia acquired Iteration::Two

Package names now com.adobe

Copyright now:
Copyright (c) 2006. Adobe Systems Incorporated.
All rights reserved.

Today, the original Iteration::Two team are 
members of Adobe Consulting EMEA group
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Not Commercial, Not Open Source
Flex documentation no where includes the 
word "Cairngorm"

Yes, Cairngorm is closely associated with Flex, but
Cairngorm is in no way "officially" a part of the Flex 
product

Currently Cairngorm lives at labs.adobe.com
Under the heading "Other Technologies"

At present, technically not open source nor a 
commercially supported product

E.g. no bugbase
License currently Adobe owns
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RESOURCES
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Cairngorm 101 – Resources
http://labs.adobe.com/wiki/index.php/Cairngorm

Source code, documentation, Cairngorm.SWC

http://cairngormdocs.org/
Sample applications and blog

6 Part Series by Steven Webster
http://www.macromedia.com/devnet/flex/articles/cairngorm_pt1.html
Note:  Code samples obsolete for Cairngorm 2.2.  

(Examples use Cairngorm 2.0.  Packages org.nevis)

Mailing Lists
http://tech.groups.yahoo.com/group/flexcoders/
http://tech.groups.yahoo.com/group/cairngorm-documentation/
http://tech.groups.yahoo.com/group/cairngorm-devel/

Books:  NONE
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Cairngorm 101 – Resources
Code Generators

Ant based:
http://www.ericfeminella.com/blog/cairngen/
Online
http://www.tylerbeck.com/archives/23/introducing-cairngorm-creator/

Adobe Blog Aggregator
http://weblogs.macromedia.com/mxna/
Note:  Use "Search" box entering cairngorm
User Groups

Flex Only:  http://www.flex.org/community/#usergroups
All:  http://www.adobe.com/cfusion/usergroups/

Conferences
http://www.adobe.com/products/flex/events/index.html
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PROs AND CONs
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What Cairngorm Is – PROs
Free of licensing costs

Extensively used and tested on large-scale RIA 
projects

A sizeable community of developers already 
versed in Cairngorm and actively supporting 
and evolving Cairngorm

There are other community projects that solve the same 
problems that Cairngorm does

ARP , MVCS, PureMVC, Guasax

Cairngorm has "early mover advantage", larger community, 
and more well proven in production
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Cairngorm Benefits
Logical structure and isolation of code, which 
supports:

Coding

Debugging

Enforces:
Loose coupling

Event driven interaction

Team development
Individual code check out

Team turnover
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Cairngorm – Criticisms
Too many files

Versus traditional OO Design where methods are 
members of the class, Cairngorm puts each method in 
its own class
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What Cairngorm Is Not – CONs
Cairngorm impacts author-time only (next slide)

Cairngorm introduces additional author-time 
overhead

Cairngorm introduces additional staff learning 
requirements

Cairngorm in no way provides any short cuts on 
learning Flex

Cairngorm is "in addition to" Flex, not "instead of"

Cairngorm in now way enhances the visual 
appearance of your apps
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Run-Time Performance – Not Cairngorm
Cairngorm's benefits do not include the 
solution of any issues related to run-time 
performance

In Flex, for improving run-time performance 
tools include:

Modules

RSLs (Runtime Shared Libraries)

Framework caching (coming in Flex 3)

Cairngorm benefits solely in authoring and 
code maintenance!

© 2007 HalcyonSolutions.net

Flex Development:  
Environment & Workflow

nib
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CAIRNGORM 
CHALLENGE
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CAIRNGORM CHALLENGE 
Source:  Steven Webster, August 21, 2006
Why I think you shouldn’t use Cairngorm

So here’s the Cairngorm challenge. The rite of passage for Flex 
developers everywhere. Open Flex Builder, and create a new Flex 
project. Import the cairngorm SWC – that’s right, not the source code, 
import the SWC. 

Now, write yourself a simple Cairngorm application, that displays a 
datagrid, calls a publicly available web-service somewhere, and then 
renders the results in the data grid.

Here’s a clue – you’re going to register one event with the controller, 
you’re going to write one command class to get the results, and to 
update the model locator when the results come in, you’re going to 
create a business delegate class for your command to invoke the web 
service with, and you’re going to register the web service with the 
service locator. 
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CAIRNGORM CHALLENGE
NOTE:  Steven's Cairngorm Challenge ends with 
the following:

Now this is way overkill for calling a 
webservice to populate a data grid. But if 
you’re ready for working with Cairngorm, the 
above will be HelloWorld.cpp to you …
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CAIRNGORM CHALLENGE
For Challenge, going to use HTTPService

URL=
http://labs.adobe.com/technologies/spry/demos/products/products.xml

Minimal UI
Just bind to datagrid
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CAIRNGORM CHALLENGE
We are going to do in 2 parts

Create app without Cairngorm

Convert app to use Cairngorm
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Quick and Easy – No Cairngorm

DEMO
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CAIRNGORM CHALLENGE 
Source:  Steven Webster, August 21, 2006
Why I think you shouldn’t use Cairngorm

So here’s the Cairngorm challenge. The rite of passage for Flex 
developers everywhere. Open Flex Builder, and create a new Flex 
project. Import the cairngorm SWC – that’s right, not the source code, 
import the SWC. 

Now, write yourself a simple Cairngorm application, that displays a 
datagrid, calls a publicly available web-service somewhere, and then 
renders the results in the data grid.

Here’s a clue – you’re going to register one event with the controller, 
you’re going to write one command class to get the results, and to 
update the model locator when the results come in, you’re going to 
create a business delegate class for your command to invoke the web 
service with, and you’re going to register the web service with the 
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CAIRNGORM CHALLENGE 
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CAIRNGORM CHALLENGE 
Import the cairngorm SWC
Register one event with the controller
Write one command class 

to get the results, and 
to update the model locator when the results come 
in

Create a business delegate class
for your command to invoke the web service with

Register the web service with the service 
locator. 
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Process – Getting Started w/ Cairngorm
Download Cairngorm Classes/SWC

http://labs.adobe.com/wiki/index.php/Cairngorm

Add the Cairngorm SWC to project library path
Select project in Navigator
From menu:  Project > Properties > Flex Build Path > 
Library Path > Add SWC

Implement directory structure and application 
classes using Cairgorm

Optionally generate class skeletons using code 
generators

Build your view classes
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Sources for Source & Sample Code
Cairngorm Classes/SWC

http://labs.adobe.com/wiki/index.php/Cairngorm

Templates for application files
Sample applications at:
http://cairngormdocs.org/

Code Generators
Ant based:
http://www.ericfeminella.com/blog/cairngen/
Online
http://www.tylerbeck.com/archives/23/introducing-cairngorm-
creator/

6 Part Series by Steven Webster
http://www.macromedia.com/devnet/flex/articles/cairngorm_pt1.html
Note:  Code samples obsolete for Cairngorm 2.2.  

(Examples use Cairngorm 2.0.  Packages org.nevis)
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Cairngorm Classes – Overview
FrontController Class (AS, extends FrontController) 

A single point of entry for all Cairngorm events
Register listeners for events along with the command class to be called 
using addCommand()

ModelLocater Class (AS, implements ModelLocator) 
A singleton for access of data stored in the swf

ServiceLocator Class (MXML, extends ServiceLocator)
A singleton for service access 

Event Class  (AS, extends CairngormEvent)
Represent user requests or system events

Command Class  (AS, implements ICommand, IResponder)
Set data on the Model 

VO Class  (AS, generally a base class)
Represents data used in the application

Delegate Class  (AS, base class with required properties)
Makes the server call and parse the data
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Cairngorm Diagram
Visualization of Cairngorm application 
processing

http://cairngormdocs.org/blog/?p=18
http://www.cairngormdocs.org/tools/CairngormDiagramExplorer.swf
[Local Copy]
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One-Time vs Recurring
Using Cairngorm, generally speaking, some 
set-up is:

One-Time

Recurring
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ONE-TIME
Cairngorm, either 

Add Cairngorm.SWC in Flex Builder
Select project in Navigator, then from menu:  Project > 
Properties > Flex Build Path > Library Path 

Add Cairngorm class files 

Directory / Package Creation 

File / Class Creation 
FrontController Class (AS, extends FrontController) 

ModelLocater Class (AS, implements ModelLocator) 

ServiceLocator Class (MXML, extends ServiceLocator) 
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RECURRING 
File / Class Creation -- Option A (versus Option B 
below) 

Event  (AS, extends CairngormEvent)
Command  (AS, implements ICommand, IResponder)
VO  (AS, generally a base class)
Delegate  (AS, base class with required properties)

File / Class Update 
FrontController Class 

Imports 
For each event 
For each command 

In Constructor, register listeners for events along with 
the command class to be called using addCommand(): 

addCommand(commandName:String, commandRef:Class):void

Option B (multiple methods on classes)
Event 
Command 
Delegate 
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If Cairngorm looks complicated … it is …

Source:  
10 Tips For Working With Cairngorm by Jesse Warden
http://jessewarden.com/2007/08/10-tips-for-working-with-cairngorm.html

1. If Cairngorm looks complicated, don’t 
worry, it is, and you’re not alone.
It takes getting used to. I felt “comfortable with 
Cairngorm” on my 4th project with it. To this 
day, I still mod it though, and try different 
things.
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Cairngorm Classes – Overview
FrontController Class (AS, extends FrontController) 

A single point of entry for all Cairngorm events
Register listeners for events along with the command class to be called 
using addCommand()

ModelLocater Class (AS, implements ModelLocator) 
A singleton for access of data stored in the swf

ServiceLocator Class (MXML, extends ServiceLocator)
A singleton for service access 

Event Class  (AS, extends CairngormEvent)
Represent user requests or system events

Command Class  (AS, implements ICommand, IResponder)
Set data on the Model 

VO Class  (AS, generally a base class)
Represents data used in the application

Delegate Class  (AS, base class with required properties)
Makes the server call and parse the data
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Adding Cairngorm

DEMO
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Future
AIR

See:  AIR Cairngorm (AIR extensions for Cairngorm)
http://www.ericfeminella.com/blog/2007/07/16/air-cairngorm-air-extensions-for-cairngorm/

AIRServiceLocator

SQLService

ISQLResponder

ISQLStatementResource

SQLStatementHelper
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Q & A
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THANK  YOU!
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THE END
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